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About CDP  

Hugh Crocker and Robert Charlebois established Crocker Data Processing Pty Ltd (CDP) in 1983 
for the purpose of developing software for the oil exploration and production industry, specifically 
in well log interpretation. Both Hugh and Robert are internationally recognized experts in the field 
of petrophysics. 

Weatherford International acquired the CDP in 2008. Originally it was based in Perth, Australia, 
with software development done in both Perth and Calgary, Canada. In 2011, the company on-
going software support operations were relocated to Brisbane, while the software development 
still remaining in Perth and Calgary. 

Weatherford International has representation in more than 100 countries and provides services in 
advanced log processing and interpretation. The current Petrolog  support is provided from 
Weatherford International office in Brisbane, Australia. 

Level 12, 133 Mary St. 
Brisbane, QLD, 4000 
Australia 

Phone: +61 7 3214 3000 
Fax: +61 7 3214 3001 
Email: info@petrolog.net 
Web: www.petrolog.net 

About Petrolog  

Petrolog  is a specialized software platform dedicated to advanced Petrophysical and Image log 
Analysis that performs many of the tasks associated with the management and evaluation of well 
log data. 

The original version of Petrolog  was first released for the oil industry on mainframe (VAX, 
PRIME) in 1982. Since then it has been ported to all popular operating systems (UNIX, Linux, 
DOS, Windows 95/98/2000/XP/Vista/Win-7). In 2006, the software was ported to the Microsoft 
dot-NET framework using the latest C# language. All features and processing methods in the 
original Petrolog  software have been ported. 

Petrolog  has been developed with the close interaction of its many users and their feedback. 
Weatherford International welcomes any comments which will contribute to the future 
development of Petrolog  to make it more powerful and intuitive for its users. 

 

Software Modules’ Overview  

Basic Module 

This module is required for the basic Petrolog  functionality and to support any additional 
modules. It includes the following items: 
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·  Import/Export Data: Petrolog  can import and export data from several industry standards 
including LIS, LAS/LBS 2.0, LAS 3.0, ASCII and SEG-Y into our proprietary binary format 
file. This module also has an extensive set of tools for verification and reading from a 
variety of legacy tape media and formats (including 9-track, DAT and exabyte tape 
media). 

·  Petrolog Desktop: The Petrolog  Desktop contains the various controls to create and 
manage a field or well based project including the Explorer, Log Listing, Workflow 
Explorer, Preferences and Calculator. 

·  Petrolog Mapview: Mapping QC tool including well paths, contouring, bubble maps and 
interactive well selection 

·  Discrete Data Management This is a set of user definable tables to allow management of 
well header information, any type of non-continuous well data (e.g. directional surveys, 
core, DST, formation tests, etc) and Strata type data (e.g. Formation Tops). 

·  Continuous Log Management: This is an extensive set of tools to manage, edit and 
perform simple processing of continuous well log data. The log editing functions include 
both tabular and graphical methods of merging, editing and TVD/TST processing. 

·  User Algorithms: A scripting language to create user defined functions and processes. 
·  Graphics: Includes plots for all log types, histograms, cross-plots (both 2D and 3D) and 

stereographic projections. All graphics can be sent to all windows supported printers and 
plotters and to a variety of graphical formats including EMF, PDF, JPG etc. 

·  Montage Editor: A graphics editor that allows users to edit and build A0 or larger 
presentations including saved plots, cross-plots, histograms and any other type of images 
in almost any graphical format. 

·  Data Mining: Includes a variety of data analysis and reporting tools. 
·  Petrolog Tools: A set of tools including a fully featured "petrophysics" calculator, utilities 

to convert existing Petrolog  V9 data and plot formats to V10, graphics conversion utilities 
and the Petrolog  evaluation request utility. 

Log Analysis 

This module provides an extensive variety of Petrophysical Log Analysis functionality including 
the following items: 

·  "Quicklook" Analysis: A set of User Algorithms to enable a user to manually perform a 
basic "step-by-step" log analysis to generate Vclay, Porosity and Water Saturation in 
sequence. 

·  CPX" Integrated Log Analysis: A fully integrated crossplot based analysis system utilising 
either the Complex Lithology, Sand-Silt-Shale (SSS) or Two Water (TWA) models. This 
technique has been developed and refined by CDP over the last 20 years and is being 
used successfully for a huge range of clastic and carbonate environments from all over 
the world. The CPX integrated analysis includes the following features and output logs: 

·  Environmental Corrections for all standard logging tools from the major Wireline 
& LWD Service Companies (Schlumberger, Halliburton, BHI, 
Weatherford/Precision/Reeves, Tucker, Probe). The log analysis processing will 
handle any mixture of different logging tools in the same well. 

·  Vclay determinations from 9 clay indicators, with non-linear transforms and 
various final Vclay indicator selection options. 

·  Ability to use any combination of external logs (Vclay, PHIT, PHIE) and input 
parameters (a, m, n, Rw etc) 

·  Gas and shale corrected Effective and Total Porosity automatically generated 
from best available porosity logs. 

·  Wide range of Saturation Equations based on both SWE (Indonesia, etc) and 
SWT (Waxman-Smits, etc) methodologies.  

·  Dual clay resistivity model and glauconite options available with all models. 
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·  Lithology and permeability determination available using various techniques. 
·  Uncertainty estimation of the key petrophysical results. 
·  Generation of a recomputed DTC, DTS and RHOB based on the results of the 

log analysis. Either the original logs or these results are used to compute and 
detailed set of Rock Mechanics and Rock Strength logs. 

·  Additional processing available for various auxiliary logging tools and techniques 
including NMR, EPT and CBM (Coal Bed Methane) using the results of the CPX 
Integrated Analysis. 

·  "CPX" Multi-well Processing: Unlimited number of wells can be processed utilising strata 
selections and a single well reference CPX analysis. 

·  Hydrocarbon Volume Reporting: Includes full single & multiwell lumping, P10/P50/P90 
petrophysical and cutoff uncertainty statistics,cutoff sensitivity module. 

·  Neural Network Analysis: Use of a Self Organising Map technique to estimate missing 
logs, permeabilities or facies based on a representative training data set. 

DLIS 

·  The Import/Export DLIS module is required to Import or Export DLIS log data. 

Multimin 

·  A Multimin Probabilistic Analysis module to complement the existing "CPX" and 
"Quicklook" deterministic approaches. This will allow the user to fully define and utilise 
any mineral, mineral property, constraint and crossplot to determine your minerals and 
lithology volumes probabilistically. 

·  An initial release is available in the Petrolog  10.5 which includes fully user definable 
minerals, properties, crossplots and a fully interactive crossplot based interface (similar to 
the CPX functionality). Further updates to the available constraints and processing 
options will progressively be introduced during 10.5 software upgrades. 

Digitize 

·  The Board Digitization module allows digitization of logs directly from film or prints using 
a digitizing board. 

Cased Hole Analysis 

·  The Cased Hole Analysis (or "Prodlog") module is used to process Sigma and Carbon-
Oxygen logs in conjunction with the Open Hole logs to determine changes in saturation 
over time. 

Geophysics 

·  The Synthetic Seismogram module includes the capability to read/write SEG-Y files, 
perform check shot corrections and compute synthetic seismograms using user defined 
wavelet convolution. 

Cross-Sections 
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·  The Cross Section module is used to generate interactive 2D multi-well cross sections. 
The 10.5 release includes full directional/horizontal well paths, user defined well plot 
templates, interwell and interactive surfaces, faults, etc. 

Imagelog 

·  The Imagelog Analysis module supports a wide range of Dipmeter and Imaging tools 
(CMI, FMS, FMI, EMI, HMI, STAR, Sonic images, BHTV, 3, 4 or 6 arm dipmeter tools, 
RAB, ADN tools, Core photos, etc.). This module includes the following features: 

·  Imagelog graphics including Tadpoles/Sinusoids, Stereonets, Stick Plots, 
Azimuth Roses and Breakout Plots 

·  Imagelog processing including accelerometer, Emex, speed corrections, button 
and pad depth shifts, arm swing, tool tilt, etc. 

·  Advanced Dip Editor and Autodip Processing 
·  Fracture Frequency and Width Analysis 
·  Advanced Stereonets 

Image Petrophysics 

·  The Image Petrophysics module includes the computation of Azimuthal RT, Vclay, 
Porosity, Grain Size Sorting and Permeability distributions from Images. Includes 
graphical zoning, multi-linear and Sw resistivity compensation. 

Sonic Waveform  

·  A Sonic Waveform Analysis module to interactively pre-process and determine 
Compressional, Shear (monopole & dipole) and Stonely DT's for all available Wireline 
and LWD digital sonic tools. Includes a zone based control file, AGC, frequency filtering 
and flexural dispersion corrections 

 

Petrolog Roadmap  

Following the Petrolog  10.0 commercial release in June 2006, an extensive array of 
enhancements and new features have being implemented for Petrolog . The ongoing release 
schedule is progressing as follows: 

Petrolog 10.5 (January 2008) 

Petrolog  10.5 includes an extensive array of improved functionality for many of the current 
modules.  

·  Environment : Improved the preferred units system, hybrid units (e.g. Canadian) now 
applies to all graphics and CPX functionality. 

·  LAS Import/Export : Various user requested workflow efficiency enhancements and 
options. 

·  Petrolog Explorer : Added a well filter using file name, wellheader field and log 
availability search criteria. 

·  Continuous Data : Logdata file read/write access upgraded to allow only one write 
process to access the logdata file 
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·  Continuous Data : Majority of dialogs & processing now "modeless" allowing continued 
interactivity during processing. 

·  Plots : Can now display any log from multiple files/wells on same plot, plus many other 
enhancements including "scroll locking" between plots. 

·  Histograms : Can be used to generate Normalised Log outputs and statistics reports 
from data/intervals displayed on Histogram. 

·  Crossplots : Extensive improvements including improved multiwell display, ghost 
background mode and additional display options. 

·  Petrophysics : Multiwell CPX crossplots now fully operational, with intuitive formation 
selection logic when changing between wells. 

·  Petrophysics : Extensive updates to the Hydrocarbon Volume Reporting module 
including a new cutoff sensitivity analysis module. 

·  Cross-Section : New module with full directional well paths and fully interactive objects 
(wells, strata, faults, etc). 

·  Mapview : Now displays well directional paths, plus many additional display options. 
·  Digital Sonic Processing : Added AGC corrections and Flexural Dispersion corrections 

to module, plus additional tool definitions. 
·  Datalogger:  Added auto-remarks plus additional depth encoder support to the FET 

datalogger software. 

 

Petrolog 10.6 (April 2008) 

Petrolog 10.6 includes a progressive revamping of the Petrolog data models to add features 
including full group functionality for continuous logs and a central "control panel" for to handle all 
well/depth interval/strata/log/unit selection. It will also include the full implementation of various 
processing modules that are still in final development (Digitial Sonic Processing, Multimin, 
Carbon/Oxygen Processing, Cross-Section, etc). 

·  Petrolog Control Panel : Upgrade of the Control Panel (Explorer, Strata and Log Listing 
displays) to display and manage all well, strata, log and unit interactions for all of the 
Petrolog application modules. The following changes will be concurrently made: 

·  Continuous Logs : Add Group (i.e. Set) functionality, improvements to logheader 
and statistics management. 

·  Discrete Data : Logical merge with continuous data (e.g. display in Log Listing, 
drag and drop, unit management, etc)  

·  Well Strata:  Shift Strata functionality (default and well) into Discrete Data to 
improve ease of use and flexibility. 

·  Units : Control panel will automatically handle all unit conversions as logs are 
passed/received to/from applications. 

·  Import/Export: Merge all Import/Export modules into a single interface, with all options 
available for every file format. 

·  Petrophysics:  Continuing improvements to CPX functionality including triaxial resistivity, 
additional NMR processing, etc. 

·  Cased Hole Analysis : Full implementation and CPX integration of Carbon-Oxygen 
Processing (RST, PGST) functionality. 

·  Multimin Processing : Full implementation including improved constraints, petrophysics 
integration and processing reporting. 

·  Cross-Section & Mapview : Further enhancements including background graphics and 
GIS map interactivity. 

·  Sonic Waveform Processing : Further processing including Shear Anisotropy 
Processing and possible Stonely Permeability or Rock Properties if client demand exists. 
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Petrolog 10.7.1.5 (September 2011) 

Petrolog 10.7.x was composed of several internal (Weatherford–only) releases, not intended for 
commercial distribution. Petrolog 10.7.1.5 is the last release of Petrolog  v 10.x prior to transition 
to Petrolog  11 and is intended as an upgrade for CDP loyal customers. It includes all bug fixes 
and incremental improvements available in the previous versions as well as implementation of 
Weatherford Compact™  toolset environmental corrections.  

Petrolog V11 (expected Q1 2012) 

Petrolog  11.0 will see a system wide upgrade of all of the Petrolog  functionality as follows: 

·  Petrolog Control Panel:  Full implementation of the control panel, and upgrade of every 
Petrolog  application to access all required processing input/output well, intervals, logs 
and units via the control panel. Every application will natively support single and multi-
well processing. 

·  Help Files: These will be fully updated as each application is standardized to the Control 
Panel. 

·  Environment : Full project based networked multi-user and security functionality via the 
Control Panel. 

·  Environment : Full multithreading of all processes, with a process management console 
available. 

·  Discrete Data : Full implementation of WITSML 1.3.1 Well Header, Discrete Well Data 
and Units standards. 

·  3D Graphics:  Interactive 3D cross-plots/histograms/plots and user defined cross-plot 
templates. 

·  User Algorithms:  Major upgrade to User Algorithm functionality including access to the 
Petrolog library routines. 

 

Getting Started  

Getting Started Overview  

This section provides an overview of installing and running Petrolog . The following key topics are 
reviewed in this section: 

·  System Requirements: Petrolog  Hardware and Software requirements and 
recommendations. 

·  Installing Petrolog: Instructions for installing Petrolog.  
·  Petrolog Network Installation: Additional Instructions to install Petrolog  to access a 

networked multi-user license. 
·  Using Petrolog Help: Accessing the Petrolog  Help system. 
·  Filename Conventions: Standard data file and Petrolog  naming conventions. 
·  First Time Users: Initial instructions to assist new users in configuring Petrolog  
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System Requirements  

Hardware Requirements  

The hardware requirements will vary according to the amount and type of processing the user is 
required to perform. 

Minimal PC  specification (suitable for loading and editing of standard resolution log data): 

·  CPU: Intel 2.0 GHz (or AMD equivalent) 
·  Hard disk (installation only): Approximately 200 MB (includes requirements for the 

.NET 2.0 framework) 
·  Hard disk (well  processing):  Recommend a minimum of 10 GB free space available for 

single well, standard log data processing. 
·  RAM: 1GB RAM 
·  Monitor:  17" or larger 

Recommended PC specification (suitable for all processing including Digital Sonic and 
Imagelog Processing): 

·  CPU: Intel 3.2 GHz or faster (or 64 Bit AMD 4200+), with dual core preferred. 
·  Hard Disk (installation only):  Approximately 200 MB (includes requirements for the 

.NET 1.1 framework) 
·  Hard disk (well processing):  Recommend 50 GB free space available (up to 400 GB 

may be required if large Imagelog files need to be processed)  
·  RAM: 2 GB DDR2 RAM 
·  Video Card:  Any fast card with 256 MB DDR3 VRAM 
·  Monitors:  Two x 20"+ high resolution Flat Panel TFT displays or larger 

Petrolog  creates temporary files during some data manipulation tasks and may require virtual 
memory on the hard drive depending on the number of files opened and your PC memory. A 
good guide is to have at least enough empty space on your drive to mirror the size of the data 
files you will have open at any time. 

For a user who wishes to perform heavy processing the following hardware specifications may 
further improve Petrolog  performance. 

·  Use a 64-bit CPU and with the Windows XP or Windows 7 64 operating system. Due to 
operating system limitations and stability issues, Windows Vista is not recommended. 

·  Changing the hard disk configuration to use RAID 0 or RAID 5 with 2 or more disks. 

Petrolog  may run at lower specification than those noted under the minimal/basic requirements 
however the performance may be degraded. 

Printers 

Petrolog  generates EMF or EMF+ files and uses the Windows drivers supplied by the 
manufacturers to generate the hardcopy output. A problem that often occurs is that many 
Windows printer drivers only support a limited length plot.  
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·  Printer:  Any printer or plotter that supports continuous printing (preferably high volume 
and a minimum A2 paper size). Some recommended printers/plotters include: 

·  Epson:  Stylus 3000 (now obsolete), Stylus pro 4000 printers. The Epson Stylus 
Pro drivers currently allow unlimited plot lengths. 

·  HP: Designjet 1000 or any other high volume Design jet plotter. The default HP 
Designjet plotter drivers will paginate plots longer than 200 inches. The solution 
is to download an HP RTL driver from the HP web site. The driver download 
program name is PL532en.exe from www.hp.com and will allow unlimited plot 
lengths on most HP Designjet plotters today. 

Digitising Boards 

·  Digitizing Boards:  Petrolog  supports an extensive range of Digitizing Boards, with the 
full list available in the Digitisers Preferences.  Due to industry consolidation, the major 
remaining digitizer manufacturer is GTCO Calcomp (see 
www.gtcocalcomp.com/digitizers/ for more details). We recommend either the 
Summagrid or Super L range of digitisers if a board needs to be purchased. 

Operating System Requirements  

The Microsoft .NET framework and Petrolog  are supported on the following platforms. 

·  Microsoft® Windows® 98, 98 SE and ME (Not Recommended) 
·  Microsoft® Windows® 2000 Professional 
·  Microsoft® Windows® XP Home Edition 
·  Microsoft® Windows® XP Professional (Recommended) 
·  Microsoft® Windows® XP Professional (64 bit) 
·  Microsoft® Windows Vista® (Not Recommended) 
·  Microsoft® Windows 7® (Recommended) 
·  Microsoft® Windows® Server 2003 family (Not recommended, some users have reported 

crashes that cannot be reproduced on non-Server versions of Windows and we have 
found that the USB Network Bitlock can't be read from a local port on the 2003 Server 
PC). 

Software Requirements  

In order to install Petrolog  the following installation files are required (available for download from 
our website at www.petrolog.net): 

·  Microsoft .NET 3.5 or higher must be installed on the user’s PC. The updates can be 
downloaded directly from Microsoft. 

·  Petrolog  installation file: Petrolog_v10.7.1.5_Setup32.exe for 32-bit systems and 
Petrolog_v10.7.1.5_Setup64.exe for 64-bit systems 

·  Petrolog10.7_Getting_Started_Guide.pdf (this document). The short version, with 
installation instructions only is also available for download. 

·  SentinelProtectionInstaller7.6.4.exe: Sentinel/Bitlock driver (required for licensing control 
with Sentinel bitlock). 

Additional/Optional Software  

Additional software packages which complement Petrolog  and the user may find useful include: 
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·  VRML plug-in for your web browser: Available if you wish to view the Petrolog  3D 
cross plots. A VRML plug-in for Microsoft Internet Explorer has been included and can be 
found in c:\Program Files\Petrolog\Installers\. 

·  Microsoft Office : The Petrolog  Discrete Data module supports full cut and paste 
functionality between Petrolog  and Excel spreadsheets. It is also recommended that 
Excel is used to generate the formatted tables of well data generated for Composite Well 
plots.  

·  XML editor : Petrolog  uses the standard windows notepad.exe by default. Petrolog  uses 
xml format for all well header, plot and preferences files. These files can be edited 
directly by knowledgeable users.  

·  Text Editor: Petrolog  uses the standard windows notepad.exe by default. The user can 
change the default to use a more advanced text editor such as Notepad++, textpad or 
wordpad if installed on the PC. 

·  PDF writer: If you require PDF format documents. Either Adobe Acrobat can be 
purchased or various freeware options are available. The PDF writer software that we 
have used successfully include the following: 

·  Adobe Acrobat: The industry standard that we are using on our XP machines. 
However, it needs to be purchased and there are freeware PDF writers that work 
as well or better. For Windows Vista users, Acrobat 8.0 is required.  

·  PDFCreator: The best freeware PDF writer available that has handled all of the 
complicated plots that we have generated. However, it currently doesn't have a 
Vista version. 

·  CutePDF: Very good, has some minor issues with complex prints. Works well 
with both Windows XP and Vista. Our main tip for using CutePDF is that if some 
graphics seem to be missing from the output pdf file, reduce the default Print 
Quality setting from 600 dpi to 300 dpi. 
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Installing Petrolog  

Please first refer to the System Requirements for further information on Hardware and Software 
requirements. Further instructions on setting up a network license can be found in the Multi-User 
Bitlock Installation help notes. 

First time Installation  

Petrolog  install files can be downloaded from the downloads section at our website at 
http://www.petrolog.net.  If required, an installation disk can be sent out upon request. 

1. Log into your PC with Administrator permission. (This may require assistance from your 
IT department if your corporate setup does not give users permission to install software 
with limited user permissions). 

2. If your PC has not had the Microsoft .NET 3.5 or above installed, please install it – refer 
to http://microsoft.com for instructions or request IT department help. 

3. Determine is you require 32-bit or 64-bit installation package and double-click on the 
corresponding installation file. Follow the on-screen instructions to install Petrolog . 

4. Double click on Sentinel installer package to install the latest version of the Bitlock driver.  

Note: The Petrolog distribution packages on our FTP server are 58Mb in size. Depending on your 
internet connection may take a while to download.  

Note: You may have a corporate firewall which will prevent you from using FTP. Please either 
consult with your IT department or contact CDP to arrange an alternate delivery method (usually 
via CD-ROM) 

CDP Recommendation : Open the Windows Explorer Folder options and set the following: 
 
1) Un-check the "Hide extensions for known file types" option (easier to recognize file types in the 
Petrolog Explorer). 
 
2) Check the "Show hidden files and folders" option (otherwise the default User area (see below) 
may be hidden in Windows Explorer).  
  

Petrolog Installation Locations 

Petrolog  uses  two main directories, the Master Area and the User Area. 
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1) Master Area : The program is installed into "c:\Program Files\Petrolog\" with the original default 
preferences set as read only. A second Master Area "c:\Program Files\Petrolog (Beta)\" is 
created when a Beta version is installed to allow side by side installations on the same PC. 

The following types of files are located in the master defaults directory: 

·  Algorithms:  Algorithms (text format) supplied with Petrolog  are located here (*.alg). 
·  Charts:  Density-Neutron and Sonic-Neutron crossplot overlays (xml format). CDP can 

add any missing charts on request. 
·  Emf:  Symbols (and logos) supplied with Petrolog  are located here. Each supplied emf 

symbol (*.emf) also has a montage file supplied (*.montage) so that the user can edit and 
create additional symbols easily using the Montage Editor 

·  Lithology:  Petrolog  Lithology patterns (*.gif format) are defined here. These patterns 
are combined with colours in the Petrolog  preferences to create lithologies. 

·  Plot:  Plot templates (xml format) supplied with Petrolog  are located here (*.plot). 
·  Xlgs : LAS export template files (xml format) supplied with Petrolog  are located here 

(*.xlgs) 
·  Xml:  Petrolog default preferences (xml format) are defined here (*.xml). 
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 2) User Area : The user area which contains all the user created configuration files is located 
under the following directories: 

·  Windows XP and below:  "c:\Documents and Settings\All Users\Application 
Data\Petrolog\"  

·  Windows Vista:  "c:\ProgramData\Petrolog\" 
·  Windows 7:  "c:\Application Data\Petrolog\” 

The User Default directory structure here is a mirror of the Master Default directory with any 
modifications made to the Master items saved into the User area. The following categories of 
user files are created: 

·  Algorithms:  User Algorithms updated or created by the user are saved here.  
·  Emf:  Any graphics objects modified or created by the user. Any logo graphics files (emf, 

gif or jpeg) required for Petrolog  plots (e.g. company logos, etc) need to be copied into 
this directory. 

·  Lithology:  Not currently used by Petrolog  
·  Plot:  Any plot templates modified or created by the user are saved here. 
·  Wellfilters : Any saved Petrolog Explorer user filters are saved here. 
·  Xlgs : Any LAS export template files modifed or created by the user are saved here. 
·  Xml:  Any updates to the default Petrolog  preferences are written here, and are loaded in 

preference to the original preferences in the Master Area. To restore the Master install 
preferences, simply delete the relevant file here. Expert users can edit these files directly 
with a xml editor if desired. 
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Re-installing or Updating Petrolog 

Remove all previous Petrolog installations as follows: 

1. Go to Control Panel -> Add or Remove Programs .  
2. Click on Petrolog 10.5 (or an earlier version if you have one) and click the Remove 

button. 
3. If there are some user preferences (e.g. Log Names Defaults, Unit Definitions, etc) that 

the user wishes to import to the new version after installation, an Upgrade User 
Preferences tool is available under Petrolog Tools > Upgrade User Preferences once 
the new version has been installed. 

4. Otherwise we strongly recommend that the Petrolog  User area is deleted before 
upgrading to the new version of Petrolog . Delete the user area at c:/Documents and 
Settings/Application Data/Petrolog/ or c:/ProgramData/Petrolog 

5. Install the new version of Petrolog  (see First Time Installation instructions above) 

Starting Petrolog 

·  Insert the supplied Sentinel bitlock into a USB port (the older parallel port bitlocks are 
also compatible with the latest Petrolog ) 

·  Click on the  icon on the desktop to start Petrolog  or select Petrolog  from the 
Windows START menu. 

·  Click on the F1 key to access the Help Contents and select the Getting Started Topic for 
a Getting Started Overview. 

Note: Petrolog  should be run for the first time after installation while still logged on with 
Administrator Permission as some of the configuration files in the Program Files directory are 
updated. After the first time run, the software can be run under a more limited User Account. 

Requesting Petrolog license  

Petrolog  license information is stored on the Sentinel bit lock. The Petrolog  license manager at 
Weatherford can create and/or update Sentinel bit lock for you. To request a new bit lock or a bit 
lock update code, run Petrolog, go to Tools and select “Bit Lock License”. The following menu will 
appear. 
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Click Email button, and the eMail text will be automatically generated. If needed, specify which 
additional software modules you would like to include and send this mail to Weatherford. The 
Petrolog  license manager will then respond to your email with a bit lock password. Cut and paste 
this to the password panel in the menu above and click on “Update”. The new permission data 
will then be registered on your bit lock.  

If you are requesting a new bit lock, apply directly to Weatherford license manager.  

Please note that it is also possible to use a single bit lock to have a shared license over the local 
network. How the shared license id set up is explained in the following chapter. 

To find out which Petrolog  modules have been enabled run Petrolog , click on File, select 
Preferences and then click on program permissions. The following dialog will appear. 
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Troubleshooting Petrolog after Installation 

Occasionally, Petrolog  fails to start correctly after a new installation, particularly when run under 
a Windows User Account with restricted or unusual settings or the PC has crashed with Petrolog  
opened. Please contact us with any details of the problem. In the meantime, the troubleshooting 
steps that we recommend be followed in these cases are: 

·  Ensure that you have the latest version Petrolog  available (either the Commercial 
release, or the latest Beta version) from our website 

·  Completely uninstall the problem version following the directions listed above, including a 
full deletion of the User area. 

·  Uninstall the .NET framework via Control Panel > Add or Remove Program > 
Microsoft .NET framework 3.5 . and select Remove. 

·  Remove the following directories if they exist: "c:\Documents and Settings\'...current 
user...'\Local Settings\Application Data\Isolated Storage". These directories are created 
by a third party library (Syncfusion) included in Petrolog  and has been known to become 
corrupted and preventing Petrolog  from starting. 

·  Reinstall Petrolog , ensuring that you are logged on in Administrator mode. 
·  Run Petrolog  again. If still unsuccessful, create a new user account and try running 

Petrolog  from there. 
·  If still unsuccessful, try installing Petrolog  on another PC. This will isolate the problem 

down to a particular machine configuration causing problems. 
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Petrolog Support 

1) Petrolog Help:  If you are having problems using Petrolog , you can view the help manual by 
pressing "F1". See Using Petrolog Help for more details 

2) CDP Support : Please email us at support@petrolog.net directly. Support is available during 
our office hours and all queries will receive a response with a solution or work around. Please 
note that we are unable to provide support over phone at this time. 

3) Problem Reporting:  To provide a solution to any problems you are having with Petrolog , we 
need enough information to be able to reproduce the problem here. In your email to CDP, please 
include as much of the following information as possible: 

·  The version Petrolog  that you are using (obtained by selecting Help > About Petrolog  
from the main menu 

·  Any error messages that occur (cut and paste the error message text into your email). 
·  The sequence of steps taken to reproduce the error. 
·  Any files needed to repeat the process (please do not send large files through email, if 

required an ftp account can be created for large file transfer). The files that need to be 
sent may include: 

·  Input Data Files (e.g. LAS, LIS, DLIS, etc) 
·  Petrolog  Data Files (e.g. .logdata, .wellheader) 
·  Petrolog  Plot Files if problem occurs with a plot open ( .plot) 
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Multi-User Bitlock Installation  

On the Server PC  

A Network Sentinel bitlock (coloured purple rather than green for a single user Sentinel bitlock) 
needs be inserted on one PC (called the "Server PC" in the following instructions) on the users 
network. 

1. Connect the Multi user bitlock on the desired PC server  

Windows 2003 Server operating system does not allow the driver to locate the Sentinel bitlock if 
the user logs into the Server from another PC. In this case, the Sentinel bitlock must be inserted 
into a different PC on the network and NSP_HOST will need to be set to the PC with the bitlock 

1. Install the Software Sentinel driver (Sentinel Installer 7.4.0.exe) from the installation CD 
or downloaded from our website on the server PC. 

2. On the server PC open a DOS Prompt window and type the command ipconfig and note 
the address of this host computer (you may need to first navigate to your Windows 
system directory such as c:\windows\system32\ to locate the ipconfig.exe file). 

  

4. In this case, the Server PC address is 192.43.189.192  
5. [optional] Copy from the installation CD-ROM the following three Sentinel utility programs 

to the Server PC. These provide useful tools for troubleshooting and monitoring the 
license status between Server and User PCs 

• loadserv.exe  

• spnsrvnt.exe 

• monitor.exe 
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On each User PC  

1. Open a DOS prompt window and type the command "ping ???.???.???.???", where ??? 
is the IP address of the Server PC as determined above. This checks that the Server PC 
is running and accessible from the User PC. 

 

2. Click Control Panel > System . Click the Advanced  tab and select the Environment 
Variables  button to display the following figure. 
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3. Click New under System Variable and add a New System Variable containing 
"NSP_HOST" and "???.???.???.??? " using the Server IP address as determined 
above. This allows the User PC to locate the Server PC and access the Network Sentinel 
bitlock. 

 

4. Reboot the User PC. 

Monitoring the Users  

1. Run the program monitor.exe on the Server PC or on a PC with Petrolog running to 
obtain the following Network Sentinel Bitlock status 
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Checking number of licenses  

2. Run Petrolog  
3. Click File > Preferences > Program Permissions  to obtain the following summary. In 

this example, Bitlock 5001 has been found at IP address 192.43.189.196. This 5 user 
Sentinel Bitlock has been limited to a single license which is being used by this instance 
of Petrolog.  
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4. If Petrolog  can not find the Network Sentinel bitlock on the network, check that the 
Server PC is on and physically has the bitlock in one of it's USB ports. Also perform the 
ping operation described above to check it is accessible from the User PC. Another 
option to monitor the bitlock status directly is via a web browser. Type in the Server IP 
address followed by ":6002" as follows: 
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5. If the Network Sentinel bitlock is still not available, we have found that the Sentinel 
Protection Service sometimes does not initialise correctly when the bitlock is removed 
and reinserted in the USB port. To restart the Sentinel Protection Service, open the 
Windows Services Dialog under Control Panel > Administrative Tools > Services.  

 

6. Double-click the Sentinel Protection Server Service , then click Stop  and then Start  to 
re-initialise the Sentinel Service. If this still doesn't work, it's time to give us a call! 
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7. If you start Petrolog , and the maximum number of users has already been reached, the 
following error message is displayed. 
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Using Petrolog Help  

Once Petrolog  is running the help system can be accessed by the following methods: 

·  From the main menu: Help > Contents, Help > Index  or Help > Search  
·  Pressing the "F1"  key for context sensitive help. 

Note: Petrolog  uses the standard Microsoft compiled html ("chm") help file format which can be 
viewed from outside Petrolog . The help file is located at c:\Program 
Files\Petrolog\Documentation\Petrolog.chm. 

This file can be run independently from Petrolog  and be used for training purposes. 

 

 

The Windows Help Display consists of the following elements: 

·  Content Panel:  The content list is designed to closely match the software main menu 
and the order in which a user would work through a particular function of the software. 
The help manual is closely linked to the section of the software that is being used. 

·  Index Tab:  Allow users to access the manual using key sections of the manual. 
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·  Search Tab : Used to search for specific topics or keywords .For example type 
"Simandoux" to find the Saturation equations containing the Simandoux equation. 

·  Glossary Tab:   Gives a list of short names and their meanings. For example XML = 
 eXtensible Markup Language.  

Filename Conventions  

We can split the associated Petrolog  files into three groups: 

Import/Export Format Files  

These can be any external file that are either POSC compliant or any other format file to store 
well log data information or reports. These files need to be converted to the Petrolog  internal 
format files for processing and include: 

·  ASCII: File or text files containing logs in columns or text remarks. Files with the .txt 
extension are ASCII format files. ASCII files written using different operating system can 
be different depending on how the line is terminated. (UNIX, DOS and Apple ASCII files 
all have different end of line format but need not be converted when used in Petrolog) . 
These files can be structured like the LAS format or non structured including wrapped 
files, comma delimited etc.  

·  DLIS: A POSC compliant format for data interchange 
·  LIS: A POSC compliant format for data interchange. Encapsulated LIS files on disk 

normally have the .TAP  extension. 
·  LAS: A POSC compliant ASCII format for data interchange. LAS 1.2, 2.0 and 3.0 

standards are supported by Petrolog.  
·  LBS: The Schlumberger Log binary format for data interchange. A combination of LAS 

header data and binary log data. However, this format is not common used. 
·  SEGY: A POSC compliant format for data interchange of seismic data. 
·  Windows compatible files:.doc, .xls , .xml, etc. These files need to be converted to either 

an ASCII format for direct import into the continuous log data or into an excel format table 
for copy and paste into the Petrolog  discrete data system. 

Graphics Format Files  

tiff, .jpeg, bnp, .cmg, .pcx and other graphical format files. These can be pixel, vector or a mixture 
of the two format files. These files are for display purpose only and cannot be used for processing 
data but can be imported in the Petrolog  montage editor. 

Petrolog Internal Format Files  

Petrolog  uses an internal binary format file to store continuous log data (array or single curve 
logs) and a various array of xml files to store other pertinent information. All the file related to a 
well will start with the same file name (usually the name of the well being processed) with an 
extension to identify the file type and content. 

Some of the extensions used by Petrolog  are: 

·  .logdata: A binary format file containing the well continuous log data. This includes 
array logs, single curve logs etc. The can be time or depth based file with unlimited length 
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and depth increment and unlimited number of columns. This file type is equivalent to the 
Petrolog  V9 .DAT file 

·  .logheader: An XML format file that contains additional information about the content the 
matching .logdata file like (Long log name, process status, tool origin, statistical 
information etc.) 

·  .welheader: An XML format file that contains the well header, strata and discrete data. 
This includes the general well header information, the field remarks, all the different 
logging run information (unlimited number of runs), formation tops and any well discrete 
or "static" data. This file type is equivalent to the Petrolog  V9 .HED file. 

·  -pro.logdata: A binary format file contains the processed results from the matching 
.logdata  file. All the logs from the .logdata files are copied initially across and 
environmentally corrected as per user instructions. This file type is equivalent to the 
Petrolog  V9 .PRO file. 

·  .logaudit.txt: This is a text file that contains the history (audit) of most of the main 
operations affecting the logs. (Date created, where logs were loaded from, shift and 
merge functions etc.). This file type is equivalent to the Petrolog  V9 .ATF file type. 

·  .procon: An XML file containing the zone control file parameters used in the log analysis 
module. It can contain an unlimited number of zones each with different parameter sets. 
There are currently over 300 zone parameters that can be modified for each zone. See 
Modify Control Parameters for additional informations. This file type is equivalent to the 
Petrolog  V9 .CON file type. 

·  .plot: XML files containing the plot configurations including track information, curve 
information, VDL displays etc. The plot file is also used as a control file to process 
formation images. (FMS, FMI, EMI, STAR etc). The plots can be sent to printers, plotters 
or files (.emf, .pdf etc.). This file type is equivalent to the Petrolog  V9 .Pxx file type 

·  .strata: An XML file containing the default strata settings (names, strata marker line 
style, colour and lithology shadings). All wells are linked to a defaults.strata file to provide 
the master list of stratas that can be defined in each well. This file type is equivalent to 
the Petrolog  V9 .FFD file. 

·  . .emf: A Windows format graphics file. Petrolog  generates emf files as its native 
format output. 

·  .montage: An XML file that defines a Petrolog  montage. A montage consists of a 
background .emf file with other graphics objects (e.g. other emfs) inserted. This file type 
is equivalent to the Petrolog  V9 .MAC macro file. 
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First Time Users  

Petrolog  is a project oriented software and it is highly recommended to set the well data files in 
clearly defined directories for easy access. 

There are too many features available to cover everything in a step by step procedure. However, 
this section can guide a new user on what to do in the correct sequence to start a log analysis. 
For more details on the full capabilities of Petrolog  the Help system should be used consistently 
to learn the tricks of the trade.  

Another option to get start using Petrolog  is to work through the Petrolog Tutorials. These 
tutorials are the same ones used in our Basic Training School. 

Step By Step Procedures  

1. Using Windows Explorer, create a directory under which all well log data files will be 
stored. (e.g. PROJECTS or WELL LOGS) 
 
This directory can be on any drive on any network provided the network drive is properly 
mapped. (e.g. drive G: in the UK, Drive H: in Houston etc.). Data processing via network 
drive will slow down operations depending on the network traffic and network speed. A 
network working at 100 megabit/second network will still be substantially slower than 
processing from the local disk drive.  

2. Under PROJECTS, create a logical directory structure drilling down to separate 
directories for each well. For example, a suitable structure may be: 

PROJECTS > 
  COUNTRY > 
     FIELD > 
         WELL-A 
         WELL-B. 

3. Copy the log data files to import from (LIS, LAS, DLIS) into the appropriate well directory. 
This also applies to the old versions of Petrolog  files with the extensions .DAT, .HED, 
.CON which were previously saved in the same directory should be copied to the 
individual well directories. 

4. Click on the  icon to start Petrolog . If you are evaluating Petrolog , see Evaluation 
License to apply for a 60 day evaluation license. 

5. Set your preferences: See Preferences Overview for further details. 
6. See Project Explorer  and use  Browse Project  to set your default start point. As 

shown in following screenshot, preferably set the project root at the highest "level" that 
you will be working in (here all directories under projects will be opened) 

7. Select a .logdata file if you have any available (identified by the blue icon ) to open this 
well. 
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8. Right mouse click on a input data file (eg LAS, LIS or DLIS and select import to create a 
Petrolog  .logdata file for this well. See LAS , LBS, ASCII, LIS, DLIS) 

9. If you have copied the old Petrolog  format files and need to convert them to the new 
Petrolog  formats (those with the extensions .DAT, .CON. .HED). See Petrolog V9 
Conversion 

10. Edit the well header file: See Edit Well Header 
11. Add the formation names. See Edit Strata Data 
12. Edit the .logdata file to check the long log names, units etc. See Modify Log Details 
13. Create a composite log: See Create Log Plot 
14. Edit/merge logs as per the help files for Continuous Logs, Merge Logs, Edit Logs, 

Function Logs 
15. Perform any graphical editing (Depth matching, log patching, Baseline shifts etc) See 

Depth Matching, Log Patching, Baseline Shift 
16. You are now ready to start the formal log analysis. See Petrophysics 


